
General Writing Guidelines 
 

I. Paper Format (MLA):    
A. Double-Spaced from your name through to the last 

line of the paper 
B. 1 inch margins 
C. Times New Roman, 12 pt. font 
D. Formatted first page (see diagram)   
E. A header, ½ inch from the top of the page with 

your last name and the page number in upper 
right-hand corner (beginning on page 2) 

 
II. Use examples in the paper.  

A. When using quotes, you do not have to use an 
entire sentence or passage; use the parts that are 
essential to your point. 

B. Always explain how your quote proves your point.  
 
III. Always cite the author and page numbers from which you 
have taken the example. 

A. You can cite the page numbers and author within 
the sentence, ―On page 48, Hawthorne writes…‖ 

B. You can use parenthetical citations: 
Cite the author in the sentence, put the page number in parenthesis--
―Wordsworth stated that Romantic poetry was marked by a ―spontaneous 
overflow of powerful feelings‖ (263).  
–OR— 
Cite both the author and the page number in parenthesis— 
Poetry is marked by a ―spontaneous overflow of powerful feelings‖ 
(Wordsworth 263). 
Note that… 
1. If a direct quote, put the quote in quotation marks 
2. The page number goes inside parenthesis 
3. The parenthetical citation is OUTSIDE the quotation mark 
4. Generally, there is no punctuation inside the end quote (see below for 
exceptions), but your period at end the sentence should be after the page 
number citation 

C. A good paper will vary these two means of citing sources. 
D. Remember that even if you paraphrase (put the example into your own words) 

you HAVE to cite your source 
E. FAILURE TO CITE A SOURCE = PLAGIARISM 

 
IV. Avoid using first and second person pronouns. You are the writer of the paper, so it is 
assumed that what you are writing is your opinion, therefore, it is unnecessary for you to say, ―I 
think…‖ Rather than using pronouns such as ―you‖ that directly address your reader, use 
generic terms such as ―the reader,‖ ―one,‖ or ―students.‖ 
 
V. The conventions of introduction and conclusion apply: You must gain the attention of your 
reader immediately, you must provide significant background, and you must close your 
introduction with a thesis statement.. Your thesis must include the following: 

 The author’s name 
 The title of the novel (either italicized or underlined) 

Your name 

Teacher’s last name 

Class—period # 

Date 

         Title 

   From your name through to the 

end of the paper, double space! 

Don’t forget to format a header 

with your last name and page 

number starting on page 2. 
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 Your chosen topic 
 What it is you want to express about that topic 

Ex: ―In Nathaniel Hawthorne’s The Scarlet Letter, the concept of forgiveness is 
forwarded as a double-edged sword, one in which forgiveness of self is as critical 
as forgiveness of others.‖ 

A. You must always strive to provide an ambitious thesis; remember that 
the thesis by itself alerts your reader of your essay’s content. Also 
keep in mind that the thesis you start with is a working thesis until 
you get to your final draft. We often start with what we think is a 
thesis statement, but once we begin working on the paper, we find 
that what we started with no longer properly reflects what the paper 
is about. Once you are satisfied with your body paragraphs, review 
your thesis to be sure it is accurate.  

B. You conclusion should reflect the essence of the thesis, what is 
learned through the process of reading and writing, a look to the 
future, and larger applications of the subject matter. 

Some guidelines for how to properly format quotes in your paper: 

Short Quotations 

To indicate short quotations (fewer than four typed lines of prose or three lines of verse) in your text, enclose the 

quotation within double quotation marks and incorporate it into your text. Provide the author and specific 

page citation (in the case of verse, provide line numbers) in the text, and include a complete reference in the 

works-cited list. Punctuation marks such as periods, commas, and semicolons should appear after the 

parenthetical citation. Question marks and exclamation points should appear within the quotation marks if they 

are a part of the quoted passage but after the parenthetical citation if they are a part of your text. 

Examples: 

     According to some, dreams express "profound aspects of personality" (Foulkes 184), though others disagree. 

     According to Foulkes's study, dreams may express "profound aspects of personality" (184). 

     Is it possible that dreams may express "profound aspects of personality" (Foulkes 184)? 

     Cullen concludes, "Of all the things that happened there/ That's all I remember" (11-12). 

  

Long Quotations 

Place quotations longer than four typed lines in a free-standing block of typewritten lines, and omit quotation 

marks. Start the quotation on a new line, indented one inch from the left margin, and maintain double-spacing. 

Your parenthetical citation should come after the closing punctuation mark. When quoting verse, maintain 

original line breaks. (You should maintain double-spacing throughout your essay.) 

Examples: 

 

Nelly Dean treats Heathcliff poorly and dehumanizes him throughout her narration: 

 

  They entirely refused to have it in bed with them, or even in their room,  

  and I had no more sense, so, I put it on the landing of the stairs, hoping  

  it would be gone on the morrow. By chance, or else attracted by hearing his  

    voice, it crept to Mr. Earnshaw's door, and there he found it on quitting  

  his chamber. Inquiries were made as to how it got there; I was obliged to 

 confess, and in recompense for my cowardice and inhumanity was sent out  

 of the house. (Bronte 78) 

{ Double

Space 
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Adding or Omitting Words In Quotations 

If you add a word or words in a quotation, you should put brackets around the words to indicate that they are not 

part of the original text.  

For example: 

 Jan Harold Brunvand, in an essay on urban legends, states: "some individuals [who retell urban legends] 

make a point of learning every rumor or tale" (78).  

 

If you omit a word or words from a quotation, you should indicate the deleted word or word by using ellipsis 

marks surrounded by brackets.  

For example: 

 In an essay on urban legends, Jan Harold Brunvand notes that "some individuals make a point of learning 

every recent rumor or tale[...] and in a short time a lively exchange of details occurs" (78).  

 

Note: If there are ellipsis marks in the quoted author's work, do not put brackets around them; only use brackets 

around ellipsis marks to distinguish them from ellipsis marks in the quoted author's work. 
 

The above information was gathered from: 

 

Owl Online Writing Lab.  Using Modern Language Association (MLA) Format.   

  Purdue University.   9 Dec. 2002.  http://owl.english.purdue.edu. 

 

 

 

 

 

 
 

 

 

 

 

 

See next page for how to format a works cited page-- 

http://owl.english.purdue.edu/
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MLA FORMAT: WORKS CITED 

 
General Formatting Rules 

 Last name page number in the upper right corner 
 The words Works Cited centered---not in bold, not underlined, not in quotation marks, 

must be 12 point font Times New Roman 
 Times New Roman  

 12 point font 
 1” margins 
 Double spaced 
 Place in alphabetical order based on the first word in the entry (whether this is the 

author’s last name or the title of an article is irrelevant), excluding a, an, the 
 Aligned left—ONLY the phrase Works Cited at the top of the page is centered 
 Do NOT number your entries 
 Hanging indent: The second line (and all lines thereafter) are indented 
 Important words in the title must be capitalized 
 Punctuation DOES matter.  Be sure to use the right type 

o Quotation marks around the title of the article 
o Book titles are underlined 
o All commas, periods, and colons are in the correct place 
o Etc. 

 

 

A BOOK WITH ONE AUTHOR:   

 

Author’s name (last name, first name).  Title and subtitle (underlined or italicized).  Place of 

publication: the publisher, date. 

A BOOK WITH MULTIPLE AUTHORS: 

Same as above, but the first author’s name is written last name, first; subsequent author names 

are written first name, last name. If a book has more than three authors, simply list the first 

author, followed by a comma, then et. al. 

 

Gillespie, Paula, and Neal Lerner. The Allyn and Bacon Guide to Peer Tutoring. Boston: Allyn, 

2000. 

 

Wysocki, Anne Frances, et. al. Writing New Media: Theory and Applications for Expanding the 

Teaching of Composition. Logan, UT: Utah State UP, 2004. 

TWO OR MORE BOOKS BY THE SAME AUTHOR: 

After the first listing of the author’s name, use three hypens and a period instead of the author’s 

name. List books by this author one after the other, alphabetically by title.  
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AN ARTICLE IN A REFERENCE BOOK: 

 

Author of article (if there is one).  Title of the article (in quotes).  The title of the reference book 

(underlined or italicized). Editor. Volume #. Publisher: Location published, year 

published.  

THE BIBLE: 

Provide the name of the specific edition, any editor(s) associated with it, followed by the 

publication information: 

 

The New Jerusalem Bible. Susan Jones, gen. Ed. New York: Doubleday, 1985. 

 

 

AN ARTICLE FROM A MAGAZINE: 
 

Author, title of the article (in quotes). Title of the magazine (underlined or italiczed), date (day 

month year): page numbers. 

INTERNET MATERIAL: 
 

Author (if available), title of article (in quotes). Title of website provider (italicized).  

 

Date article was published (if available). Name of institution/organization affiliated with 

the site. Date you accessed the site <web address>. 

Stolley, Karl. “MLA Formatting and Style Guide.” The OWL at Purdue. 10 May 2006. Purdue 

University. 21 June 2007 <http://owl.english.purdue.edu/owl/resource/557/01/>. 

DATABASE: 

 

Author (if available).  Title of article (in quotes). Title of source in which it was originally 

published (underlined or italicized if it as a book, in “quotes” if it was a magazine or 

newspaper), volume #, date of publication (in parenthesis): page number of original 

publication. Name of database. Library providing access, City, State (of the library 

providing access). Date accessed <web address>. 

Miller, Donald L. “The white city.” American Heritage, 44, (1993): 70. History Resource 

Center: US. Plainfield South Media Center. Plainfield, IL. 21 June 2007 

<http://galenet.galegroup.com>. 
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A WORK IN AN ANTHOLOGY OR COLLECTION (for example, the Bloom’s books) 

Last name, First name (of person who wrote the entry in the book). "Title of Essay." Title of 

Collection. Ed. Editor's Name(s). Place of Publication: Publisher, Year. Pages.  

Some actual examples: 

Harris, Muriel. "Talk to Me: Engaging Reluctant Writers." A Tutor's Guide: Helping Writers 

One to One. Ed. Ben Rafoth. Portsmouth, NH: Heinemann, 2000. 24-34.  

Swanson, Gunnar. "Graphic Design Education as a Liberal Art: Design and Knowledge in the 

University and The 'Real World.'" The Education of a Graphic Designer. Ed. Steven 

Heller. New York: Allworth Press, 1998. 13-24. 

Cross-referencing: If you cite more than one essay from the same edited collection, the MLA 

indicates that it is optional to cross-reference within your works cited list in order to avoid 

writing out the publishing information for each separate essay. You should consider this option if 

you have many references from one text. To do so, include a separate entry for the entire 

collection listed by the editor's name. For individual essays from that collection, simply list the 

author's name, the title of the essay, the editor's last name, and the page numbers. For example: 

L'Eplattenier, Barbara. "Finding Ourselves in the Past: An Argument for Historical Work on 

WPAs." Rose and Weiser 131-40.  

Peeples, Tim. "'Seeing' the WPA With/Through Postmodern Mapping." Rose and Weiser 153-

167. 

Rose, Shirley K, and Irwin Weiser, eds. The Writing Program Administrator as Researcher. 

Portsmouth, NH: Heinemann, 1999. 

 

 

Sample Works Cited page on next page… 

 

Source: OWL at Purdue website: http://owl.english.purdue.edu/owl/resource/557/07/ 
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Works Cited 

 

Adeline, Mark.  Love in Black and White.  New York: HarperCollins Publishers, 1992.     

 

Cartwright, David.  “Memories of a Native Son.”  People Weekly.  7 July 1986: 8-9.    

 

Miller, Donald L. “The white city.” American Heritage, 44, (1993): 70. History Resource 

Center: US. Plainfield South Media Center. Plainfield, IL. 21 June 2007 

<http://galenet.galegroup.com>. 

Stolley, Karl. “MLA Formatting and Style Guide.” The OWL at Purdue. 10 May 2006. Purdue 

University. 21 June 2007 <http://owl.english.purdue.edu/owl/resource/557/01/>. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

But wait, there’s more!! 
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MLA Formatting: 

A “How To” Guide 

 
Most of this is easiest to do if you just set up your document BEFORE you begin typing. Here’s 

how: 

 

IF YOU ARE USING OFFICE 2007: 

**When you open a new document, BEFORE YOU BEGIN TYPING, be sure you’re on 

the “Home” tab. In the “Styles” section of the toolbar at the top, select the button that says 

No Spacing.** 
1) Double spacing:  

A) BEFORE you begin typing, press the Ctrl key and the 2 key at the same time.  

  ---OR--- 

B) Make sure you’re on the “Home” tab. Find the word “Paragraph.” In the bottom right 

corner is an arrow. Click on this to open the “Paragraph” dialog box. Find the spot where 

it says “Spacing.” At the “Line Spacing,” pull-down menu, select “Double.”  Click “OK.” 

2) 1-inch margins:  

Choosing “No Spacing” will automatically set your margins at 1-inch 

3) Times New Roman font:  

With toolbar displaying the “Home” tab, change your margin to Times New Roman from 

the pull-down menu on the left. 

4) 12-pt font:  
With toolbar displaying the “Home” tab, change your font size to 12 pt. 

5) Headers with last name and page number:  

The EASIEST way: 

At the very top of the page, double click. You should see a blue dotted line, and a tab that 

says header. Before  you type anything, check the box on the right of the toolbar that says 

“different first page.” If you don’t see  that, make sure you’re on the “Design” tab of the 

header. Your header will seem to disappear from the document if you’re still on the first 

page. Don’t worry, it’ll be there starting with page 2. Then click on the “Page #” icon. 

Select “Top of Page,” then “Plain Number 3.” Then type your LAST name ONLY. Now 

click on the tab that says “Home.” Highlight then change the font to Times New Roman, 

12 pt. Double click outside of the header. Your name and page number will automatically 

appear on every page. 

OR 

Click the “Insert” tab on the toolbar. Click on the “Page Number” button.  From the 

options, select “Top of Page,” then “Plain Number 3.” Then type ONLY your LAST 

name. In the right of the toolbar at the top of the page is a box that says “Different first 

page.” Check this box. Your header will seem to disappear from the document if you’re 

still on the first page. Don’t worry, it’ll be there starting with page 2. Now click on the 

tab that says “Home.” Highlight then change the font to Times New Roman, 12 pt. 

Double click outside of the header. Your name and page number will automatically 

appear on every page.  

6) Hanging indent (for works cited page):  

Make sure you’re on the “Home” tab. Find the word “Paragraph.” In the bottom right 

corner is an arrow. Click on this to open the “Paragraph” dialog box.  Under 

“Indentation,” open up the pull-down menu for “Special,” and select “hanging.” Now 

click “OK.” 

 

 

 

Keep going… 
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IF YOU ARE USING AN OLDER VERSION OF MICROSOFT WORD… 
1) Double spacing: 

A) The easy way—before you start to type, on your keyboard, just hold down “Ctrl” 

and 2 at the same time 

B) A little more complex, but just as effective, before you start typing, click Format 

(on the toolbar above), then Paragraphs. Scan down to “Spacing.” Under “Line 

Spacing” is a box with a pull-down arrow. Click on that arrow, then select 

“double” 

C) If you already started typing your paper, highlight what you’ve already typed by 

hitting “Ctrl” and “A” at the same time. While your text is highlighted, hit “Ctrl” 

and 2 at the same time, --OR—while your text is highlighted, follow the steps in 

option B above. 

 
2) 1-inch margins: 

Go to File on the toolbar. Then Page Setup. Margins immediately comes up. Leave Top 

and Bottom alone. Change Left and Right to 1” by arrowing down. 

 

3) Times New Roman font: 

The toolbar up at the top of the page has a box for the type of font you want to use. Be 

sure “Times New Roman” is selected 

 

4) 12-pt font: 

Select 12 in the font size box of the toolbar at the top of the page 

 

5) Headers starting on page 2: 

1) Select View from the toolbar on the top of the page. Then click on “Header and Footer.” 

A box will appear at the top of the page. Make sure the cursor is along the right margin 

by clicking on the Align Right option on the toolbar at the top of the page (it’s the box 

that shows all lines of text lined up along the right, but not the left). Type in your last 

name. Then click close. 

2) Once you’ve done that, select Insert from the toolbar on top of the page. Then Page 

Number. Position is “Top of the Page (Header).” Alignment is right. Then UNCHECK 

the box that says to show the number of the first page. Click “OK.” 

 

6) Hanging Indent (for your Works Cited page): 

Before you begin typing your Works Cited page, go to Format on the toolbar. Then 

Paragraph. In the middle section of the box it says “Indentation.” Toward the right side of 

the box it says “Special” then there’s a pull-down box. Click on the arrow. Select 

“Hanging.” Click “OK.”  

 

IF YOU ARE USING PAGES ON A MAC… 

1) Double spacing: 

If you haven’t changed the default toolbar, toward the right is a box with the number 1.0 in it. If 

you go to that box, it’ll give you lots of options for line spacing. Choose 2.0. If you don’t see that 

box, click on Inspector (the italic i in a blue circle on the toolbar).  Under “Document” click on 

the T. Change the line spacing to double. 

 

2) 1-inch margins: 

 It will default to 1-inch margins—you don’t have to change anything. 

 

3) Times New Roman font: 

 Select “Times New Roman” from the pull-down menu of font types on the toolbar. 

This wondrous info continues on the next page… 
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4) 12-pt font: 

 It will default to 12-pt font. Change nothing. 

 

5) Header 

Move your cursor to the top of the page. A box will appear across the entire top of the page. Click 

inside that box. In the toolbar at the top of the page, align your text to the right. Type ONLY your 

LAST name. Then click “Insert” at the top of the screen. Then page number. To get rid of the 

header on the first page, go to Inspector on the toolbar.  Click on the second button at the top of 

inspector—Layout inspector. Click “Section.” Check the box that says “First page is different.” 

Your header will go away on the first page, but remain on the rest of the document. 

 

6) Hanging indent 

Type up your Works Cited page. Be sure each entry starts with the first line aligned to the left 

margin. Hit “Enter” ONLY at the end of an entry, just like you would if you were finishing up a 

paragraph and starting a new one. When you’re done, highlight the section to which you need to 

apply the hanging indent.  Go to Inspector at the top of the page. Click on the T at the top of the 

box. Then click on “Tabs.” Leave first line at 0 in. Change Left to 0.5 in. You’ll see the necessary 

lines indenting as required.  

 

 

 

 
 

 

 

 

 

One more page… 



Smith 11 

 
Miscellaneous FAQs 

 

How do I format an outline? 

Microsoft Word likes to try to do everything for you. When doing an outline, this can drive 

you nuts. To save your sanity, BEFORE you start typing your outline, do the following: 

If you are using Word 2007: 

 A) Click on the Windows icon in the upper left corner of your screen. 

 B) At the bottom of that dialog box, select “Word Options” 

 C) Select “Proofing” from your options on the left. 

 D) Click the button that says “AutoCorrect Options” 

E) In the tab that says “Autoformat” UNCHECK “automatic bulleted lists.” In the tab 

that says “Autoformat as you type” UNCHECK “automatic bulleted lists” and “automatic 

numbered lists.” Then click OK. This should turn off the autoformat as you try to type 

your outline. 

If you are using an older version of Microsoft Word: 

Go to Format on the toolbar at the top of the page. Select “Auto Format.” Then 

“Options.” In the tab that says “Autoformat” UNCHECK “automatic bulleted lists.” 

In the tab that says “Autoformat as you type” UNCHECK “automatic bulleted lists” 

and “automatic numbered lists.” Then click OK. This should turn off the autoformat 

as you try to type your outline. 

 

How do I save a paper as an older version of Word so that I can open it at home? 

***Newer versions of word, such as 2007 can open older versions of word, but an older version 

of Word can NOT open a newer one. If you have an older version of word at home, and you want 

to work on an assignment at home that you started or worked on here at school, you HAVE to 

save what you’ve worked on here as an older version of Word.*** Click on the Windows icon at 

the top of the page. Move your cursor to “Save As.” From the options that pop up to the right, 

select “Word 97-2003 Document.” This document will still open here at school if you work on it 

at home.   

 

How do I save a paper as a Word Document if I’m working on it at home but need to bring it 

here to school to work on? 

If you do not use Microsoft Word at home, but you want to bring and open it here at school, it is 

essential that you save your paper as a Word Document, or you won’t be able to open it here at 

school. When it’s time to save your paper, select File, then Save As. Just below the space where 

you title your paper, there is a pull-down menu. Click on that arrow. From that list, select “Rich 

Text.” Then save it. That is the version of the assignment that you want to send or save to a disk 

so that it will open here at school.  

 

How do I save a paper to a disk or flash/thumb drive? 

Simply clicking on the disk on the toolbar will not save a document to a disk or flash drive. With 

the document open, go to the Windows icon in the upper left hand corner (File on the toolbar on 

older versions of Word). Then Save As. From there you will have to select the destination to 

which you’d like to save your file. If it’s a floppy disk, it’s likely the A: drive. The drive name for 

a flash/thumb drive varies. You will have to look through your options to determine which one is 

the flash/thumb drive. Once you’ve selected where you’d like the document saved to, click 

“Save.” I suggest then checking the disk or thumb/flash drive to be sure you’ve actually saved the 

document there. 

 

I hope these instructions are helpful. If you need more clarification, please ask! :o) 

 

 


